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2 Raportin laatiminen: Valtion ostolaskut 

2.1 Yleisnäkymä-raporttisivun laatiminen 

Harjoituksessa laaditaan ensin alla olevan kuvan kaltainen raporttisivu. Älä turhaan keskity pikselintarkkoihin 

yksityiskohtiin, sillä lopputulokset ei tarvitse tulla identtisesti kuvan mukainen.  

  

 

 

2.2 Ohjeita 

Jos olet joko Power Queryssä tai Data-näkymässä, siirry ensin Power BI -pääikkunassa vasemmalla ylimmäisenä 

näkyvään raportointinäkymään. 

Power BI Desktopista tulee kuukausittain uusi versio, joten harjoituksen kuvaruutukaappaukset eivät välttämättä ole 

täsmälleen saman näköisiä kuin käytössäsi olevassa Power BI Desktopissa. 
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2.2.1 Raporttisivun nimi ja tausta 

Vaihda raporttisivun nimeksi Ostolaskut yleisnäkymä joko 
kaksoisnapsauttamalla sivun nimeä tai pikavalikossa olevan komennon 
avulla. 
 

 
 
Valitse visualisointipaneelista oikealta muotoilupaneelista sivun taustaksi 
(canvas background, piirtoalustan tausta) mahdollisimman vaalea 
harmaa sävy.  
 
Kun määrität harmaan taustan, se on oletusarvoisesti 100 % läpinäkyvä 
(transparency) eli ei näy lainkaan. Säädät läpinäkyvyyttä säätimen avulla. 
 
Kiinnitä huomiota, että voisit muuttaa myös raporttisivun kokoa 
muotoilupaneelin asetusten kautta (canvas settings, piirtoalustan 
asetukset). 

 
 

2.2.2 Logo 

Lisää sivun oikeaan yläkulmaan logo komennolla Insert > Image (Lisää > Kuva). Käytä 
harjoitustiedostojen joukossa olevaa Ostoskärry.png -nimistä tiedostoa. Säädä kuvan koko 
melko pieneksi. 
 
Siirrät kuvaa helpoiten kuvan oikeassa ylä- tai alakulmassa olevasta kolmesta pisteestä 
tarttumalla. 

 

 

2.2.3 Sivun otsikko 

 

Lisää sivulle otsikko komennolla Insert > Text box 
(Lisää > Tekstiruutu) ja kirjoita otsikkotekstiksi 
Valtion ostolaskut yleisnäkymä.  
Voit valita tekstiä ja muotoilla esimerkiksi fonttikokoa 
tekstiruudun läheisyyteen ilmestyvän 
muotoilutyökalurivin avulla. Säädä tekstiruudun koko 
suurin piirtein sen sisällä olevan tekstin kokoiseksi. 
Huolehdi, ettei tekstiruutuun jää näkyviin 
vierityspalkkeja. 
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Kun tekstiruutu on valittuna, muotoilet tekstiruudun ulkoasua oikealla 
näkyvän Format text box (Muotoile-testiruutu) -paneelin avulla. 
Poista käytöstä tekstiruudun valkoinen tausta (background, tausta).  
 
Tallenna tiedosto aiemman version päälle. 
 

 
2.2.4 Klusteroitu palkkikaavio (Clustered Bar Chart) 

 

 
 
Napsauta tyhjässä kohdassa sivulla ja luo raporttisivun vasempaan 
reunaan otsikon alle palkkikaavio (clustered bar chart).  
 
Sijoita kaavion akselille (Axis) hankintakategoria ja arvoiksi (values) 
tiliöintisumma.  

 

 
Varmistu vielä tiliöintisumma-kentän valikosta, että visualisointiin 

lasketaan summa (sum). Ks. viereinen kuva → 
 
Tiedoksi: Numeerisista kentistä lasketaan aina oletusarvoisesti 
summa ja tekstikentistä määrä (count). 
 
Huomaa, että voisit halutessasi vaihtaa kentän nimen samasta 
valikosta (Rename for this visual). 
 
 

 

  
 



 

HARJOITUS 2 4 (16) 

 

 
Kun palkkikaavio on valittuna, löydät visualisoinnin 
muotoilupaneelin General (Yleinen) -välilehdeltä Title (Otsikko) -
muotoiluryhmän.  
 
Vaihda kaavion otsikoksi Ostot hankintakategorioittain (€).  
 
Silmäile mitä muita muotoiluita voisit tehdä otsikolle. Supista lopulta 
Title (Otsikko) -muotoiluryhmä. 
 

 

 
 
Huomaa että General (Yleinen) -välilehdellä 
on yleisiä kaikille eri kaaviolajeille tyypillisiä 
muotoiluita (otsikko, tausta, reunaviiva).  
 
Visual (Visualisointi) -välilehdeltä löytyvät 
juuri valittuna olevaan kaaviolajiin (esim. 
klusteroitu palkkikaavio) liittyvät muotoilut 
(esim. akselit). 

 

Y-akselille varattu tila on oletusarvoisesti vain 25 % kaavion 
leveydestä, joten otsikot katkeavat hyvin lyhyiksi, kuten ”ICT-
hankinnat (t…”. 
 
Etsi Visual (Visualisointi) -välilehdeltä Y-akselin muotoiluryhmä ja 
määritä Y-akselin enimmäiskooksi (max area width, alueen 

enimmäisleveys) 50 % kaavion leveydestä. → 
 
Poista Y-akselin muotoiluryhmässä olevalla asetuksella Y-akselin 
otsikko (title). Poista myös X-akselin otsikko.  Supista lopuksi sekä Y- 
että X-akselin muotoiluryhmät. 
 
Vinkki: muotoiluita ja asetuksia on helppo etsiä hakusanoilla. 
Kokeile! 
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Kokeile, miten voit lajitella kaavion sisältöä kolmen pisteen valikon 
avulla.  Painike näkyy joko kaavion oikeassa ylä- tai alakulmassa. 
Kokeile myös kolmen pisteen painikkeen edessä olevaa tarkastelutila 
(focus mode) painiketta, joka laajentaa visualisoinnin täyteen 
kokoon.  
 
Palaa lopuksi tarkastelutilasta takaisin normaalinäkymään Back to 
Report -vaihtoehdolla. 
 
Tallenna. 
 

 

 

2.2.5 Klusteroitu pylväskaavio (Clustered Column Chart) 

Luo palkkikaavion oikealle puolelle melko matala pylväskaavio (clustered column 
chart). 
 

 
 
Valitse X-akselille tositepvm-kentän hierarkiasta sekä Vuosi että Vuosineljännes, 
jolloin visualisointiin muodostuu hierarkinen rakenne.  
 
Sijoita kaavion arvoksi (values) tiliöintisumma. Huomaa, että myös arvoksi voisi 
sijoittaa useita lukuja, jolloin kaavioon muodostuisi useita pylväitä. 
 
Poraudu Vuosineljännes-tasolle visualisointiin ilmestyneen atraimen näköisen 
nuolipainikkeen avulla.  
 

 
 
Vaihda kaavion otsikoksi (title) Ostot vuosittain ja neljänneksittäin (€). Poista 
tästäkin kaaviosta sekä Y- että X-akseleiden otsikot. Vihje: käytä hyödyksi 
hakukenttää ja etsi hakusanalla title (otsikko). Varo, ettet poista kaavion otsikkoa. 
 
Käy myös muotoilemassa X-akselia siten, että poistat eri hierarkiatasojen 
otsikoiden yhdistämisen.  Tämä jälkeen vuosineljännekset näkyvät x-akselilla 
vuoden ”alaisuudessa”. Ks. viereinen kuva -> 
 
Tallenna. 
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2.2.6 Taulukot (Table) tai matriisit (Matrix) 

Lisää pylväskaavion alapuolelle 1) taulukko tai 2) matriisi ja 
sijoita siihen toimittajan nimi sekä tiliöintisumma. Voit käyttää 

harjoituksessa kumpaa visualisointilajia tahansa.  → 
 
1) Taulukko (table) on pelkkä luettelo.  
2) Matriisiin (matrix) voi sijoittaa monipuolisemmin tietoja myös 
hierarkisesti ja erikseen rivi- sekä sarakeotsikoiksi. Matriisi 
muistuttaa enemmän Excelin pivot-taulukkoa kuin pelkkä 
taulukko (table). 
 
Voit säätää taulukoiden ja matriisien sarakeleveyksiä kuten 
Excelissä sarakeotsikoiden välistä vetämällä.  
 

 
 
Lajittelet taulukon tai matriisin sisältöä joko napsauttamalla 
visualisoinnin sarakeotsikoita tai kolmen pisteen avulla. Kokeile. 
 
Jätä visualisointi lopulta tiliöintisumma perusteella lajitelluksi 
siten, että suurimmat toimittajat ovat ylimmäisinä. 

 
 

 
 

 
 
 

 
Tuo visualisointiin otsikko (title) esiin muotoilupaneelin avulla ja 
kirjoita otsikoksi TOP 10 toimittajat (€). 

 

 
Tarkista, että taulukko/matriisi on valittuna ja suodata 
visualisointia oikealla näkyvästä suodatuspaneelista (Filters)  

(1) Toimittajan nimen perusteella siten, että 
(2) visualisoinnissa näytetään vain 10 suurinta toimittajaa. 
(3) Kuljeta hiirellä tiliöintisumma -kenttä 

suodatuspaneeliin suodatusperusteeksi (By value) ja 
(4) napsauta Ota suodatus käyttöön (Apply filter). 
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Raporttisivun pitäisi näyttää suurin piirtein alla olevan kaltaiselta: 

 

2.2.7 Osittajat (Slicers) 

Lisää sivun oikeaan reunaan neljä eri osittajaa 
(slicers), joista käyttäjä voi tehdä valintoja.  
 
Sijoita ensimmäiseen osittajaan tositepvm-
hierarkiassa oleva Vuosi ja muihin 
hankintakategoria, palveluryhmä sekä toimittajan 
nimi. Tällä hetkellä Vuosi-osittaja ei ole tarpeellinen, 
mutta oletetaan, että dataan on tarkoitus päivittää 
useamman vuoden tiedot. 
 
Huomaa, että osittajien ulkoasu riippuu osittajaan 
valitun tiedon tyypistä. Numeerinen osittaja, kuten 
Vuosi, on oletusarvoisesti jana ja tekstiosittaja on 
oletusarvoisesti valintalista. 
 
Voit vaihtaa osittajan ulkoasua niiden oikeassa 
yläkulmassa olevan valikon avulla.  Numeerisissa ja 
tekstiosittajissa on tarjolla erilaisia vaihtoehtoja. 
 

 

 Osittaja (slicer) 
 

 
 

Kokeile, miten esimerkiksi hankintakategoria -osittaja käyttäytyy, jos yrität valita useita eri toimialoja?  Pystytkö 
valitsemaan useita vaihtoehtoja Ctrl-näppäimen avulla? 
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Määritä kaikki osittajat sellaisiksi, että niistä voi valita useita vaihtoehtoja 
ilman ctrl-näppäintä. tuo myös Select All (Valitse kaikki) -vaihtoehto 
näkyviin. Löydät tarvittavat asetukset Visual > Slicer settings > Selection 
(Visualisointi > Osittajan asetukset > Valinta) -muotoiluryhmästä. Kuva 

oikealla → 
 
Tuo toimittajan nimi -osittajaan esiin myös hakukenttä (Search). Saat sen 

esiin visualisoinnin ”kolmen pisteen” -valikosta.   
 

 
 
Kokeile hakukentän avulla löydätkö oman yrityksesi valtion toimittajien 
joukosta. 
 

 

 

 
Vaihda lopuksi vuosi-osittaja luettelo (list) -tyyppiseksi ja muut osittajat 
avattava valikko (dropdown) -tyyppisiksi. Tee osittajista matalampia. 
 

 
Jos kokeilit osittajista erilaisia valintoja, poista valinnat lopulta kunkin 
osittajan oikeassa yläkulmassa olevan pyyhekumi-painikkeen avulla. 
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Huomioita 
 
Usein osittajiksi sijoitetaan vain oleellisimpia valintavaihtoehtoja, sillä 
ne vievät tilaa raportilta.  
 
Jos kuitenkin käyttäjät tarvitsevat monipuolisempia 
valintavaihtoehtoja, niitä voi tarjota kuljettamalla kenttiä 
suodatuspaneeliin esimerkiksi Filters on all pages (Kaikkien sivujen 
suodattimet) -alueelle. Kokeile. 

 
 

2.2.8 Kokeile, testaa ja kysy tarvittaessa 

• Kuljeta hiiri jonkun pylvään tai palkin päälle. Huomaa, että esiin tulevassa työkaluvihjeessä (tooltip) näytetään 

kaikki ne tiedot, joita olet sijoittanut visualisointiin. 

 

 
 

Vinkki: Voit rikastaa visualisointia lisäämällä työkaluvihjeeseen (tooltip) tietoja, kuten laskujen lukumäärän. 

Sijoita esim. lasku_id työkaluvihjeeksi ja vaihda laskutoimitukseksi lukumäärä (count distinct). Vaihda samasta 

valikosta myös nimeksi laskujen lkm.  
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• Vuorovaikutteisuus: Napsauta jotain palkkikaavion sinistä palkkia. Muuttuvatko muut sivun visualisoinnit 

valintasi perusteella? Kun napsautat samaa palkkia uudelleen tai napsautat palkkikaavion valkoista taustaa, 

valinta poistuu. Voit myös valita useita palkkeja Ctrl-näppäimen avulla ja poistaa valinta napsauttamalla 

palkkikaavion tyhjää taustaa. Kokeile. 

 

• Valitse laatimastasi osittajasta jotkut kaksi palveluryhmää (esimerkiksi sekä ICT-laitteet että ICT-palvelut). Kun 

katsot raporttia, mistä voit varmistua mitä valintoja olet tehnyt? 

 

VASTAUS: Kuljeta hiiri minkä tahansa visualisoinnin ylä- tai alakulmassa näkyvän suodatussymbolin päälle, 

jolloin näet tekemäsi valinnat. 

 

 
 

• Tyhjennä lopulta valinnat osittajissa olevien pyyhekumipainikkeiden avulla. Huomaa, että pilvipalvelussa 

raporttia katsoessaan käyttäjät näkevät raportin yläpuolella Reset (Palauta) -painikkeen, jolla he voivat 

helposti tyhjentää kaikki erilaiset tekemänsä valinnat. Power BI Desktopissa ei ole vastaavaa painiketta, sillä 

Desktop ei ole varsinaisesti tarkoitettu raporttien katsomiseen. Vastaavan painikkeen pystyisi laatimaan 

Power BI -kirjanmerkkien avulla. 

 

2.2.9 Kortit (Cards) 

Lisää vielä raporttisivun yläosaan otsikon alapuolelle kaksi korttia (123), sillä 
yleensä käyttäjän on hyvä saada yleiskuva aihepiiristä heti raporttisivulle 
saapuessaan. Kortteihin sijoitetaan yleensä oleellisimpia tunnuslukuja. Siirrä 
ja järjestä muita visualisointeja tarpeen mukaan. 
 
Sijoita ensimmäiseen korttiin tiliöintisumma ja jälkimmäiseen toimittajan y-
tunnus. 
 

 
 
Tarkista, että ensimmäiseen korttiin lasketaan summa ja vaihda toimittajan 
y-tunnuksen perusteella laskettavaan korttiin laskutoimitukseksi erillisten 
määrä (count distinct). 
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Vaihda ensimmäisen kortin tekstiksi ”Ostot €” ja jälkimmäiseen korttiin 
tekstiksi ”Toimittajien lkm” Rename for this visual (Nimeä tämä visualisointi 
uudelleen) -valikkokomennolla.  
 
 

 
 
 
Jos haluat näyttää luvut ilman näyttöyksikköä (kuten bn, mrd, M, k), 
vaihda muotoilupaneelista Visual > Callout value > Display units 
(Visualisointi > Kuvaselitteen arvo > Näyttöyksiköt) -kohtaan None (Ei 

mitään). Poista myös desimaalit. → 
 

 

 

 
Lisätietoja näyttöyksiköistä 

Kun luot kortteja ja muita visualisointeja, näyttöyksiköt (K=kilos, t=tuhatta; M=millions, Milj. = miljoonaa; bn=billoin, 

Mrd.=miljardia jne.) perustuvat käyttämääsi Power BI Desktop -kieliversioon. Kun loppukäyttäjät katsovat raportteja 

pilvipalvelussa, he näkevät näyttöyksiköt sen kielen mukaisesti, minkä kielistä pilvipalvelua he ovat päättäneet 

käyttää.  

Raportin laatija ei siis tiedä eikä pysty vaikuttamaan millaisia näyttöyksiköitä loppukäyttäjät näkevät. Suomenkielinen 

pilvipalvelu näyttäisi ensimmäisessä Ostot € -kortissa tekstin Mrd. ja englanninkielinen tekstin bn.  
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2.3 Lopputulos 

Tässä vaiheessa raporttisivun pitäisi näyttää suurin piirtein seuraavalta. 

 

2.3.1 Sivukohtainen suodatus 

Oikealla olevasta suodatuspaneelista (filters) voi toteuttaa erilaisia suodatuksia kuljettamalla kenttiä 

suodatuspaneelissa oleville alueille (visual level filter, page level filter ja filters on all pages).  

Kokeile muodostaa sellainen raporttisivun, jossa käyttäjille näytetään vain tietyn yläorganisaation tietoja (esim. 

Oikeusministeriön hallinnonala).  Voit kokeilla sivun muodostamista tekemällä ensin kaksoiskappaleen nykyisestä 

sivusta ja testailemalla suodatuksia kaksoiskappalesivulla. 

 

Kyseistä testisivua ei haluta jättää näkyville tähän raporttiin, joten piilota sivu ettei se näy loppukäyttäjille, kun sivu 

julkaistaan. 
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2.3.2 Viimeistely 

Tarkastele alkuperäistä raporttisivua ulkopuolisen silmin. Tarkista, että visualisoinnit ovat havainnollisia, otsikot 

kuvaavia ja tekstit riittävän isolla fontilla. Testaa vielä, että osittajat toimivat ja että käyttäjä voi helposti valita useita 

vaihtoehtoja osittajista. 

Jos haluat tasata visualisoinnit siististi vaikkapa yläreunoista tai tasata esimerkiksi kortit vaakasuuntaisesti yhtä 

pitkälle toisistaan, valitse tasattavat visualisoinnit joko Ctrl-näppäimen avulla tai piirtämällä niiden ympärille 

”näkymätön kehys”. Visualisointien valitsemisen jälkeen ylös valintanauhaan ilmestyy Format (Muotoile) -välilehti 

tasaustoimintoineen. Tasauskomennot toimivat kuten monissa muissa ohjelmissa (esim. PowerPoint). 

 

 

3 Tallenna lopputulos ja kerro kouluttajalle, että olet valmis.  

Jos muilla osallistujilla on vielä harjoitus kesken, voit esimerkiksi kokeilla eri visualisointeja hetki sitten laaditulla 

testisivulla ja/tai laatia millaisen raporttisivun tahansa. Voit myös käydä seuraavassa olevia lisäesimerkkejä läpi. 
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4 Lisäpuuhaa: Kokeile erilaisia visualisointeja 

 

Tee raporttisivusta vielä yksi duplikaatti ja valitse 
kopioidulta sivulta esimerkiksi 
hankintakategorioittainen palkkikaavio ja kokeile 
muutamia erilaisia kaaviolajeja.  
 
Voit halutessasi tarkastella eri kaaviolajeja myös 
laajentamalla kaavion ensin tarkastelutilaan (focus 
mode) kaavion oikeassa yläkulmassa olevan painikkeen 
avulla.  
 

 

 

Jos kokeilet alimmalla visualisointirivillä olevaa 
hajotuspuuta (decomposition tree), visualisointi 
näyttää vain valittuna olevan laskennallisen arvon 
eli tiliöintisumman. Voit jakaa luvun 
hankintakategorioihin luvun vieressä olevalla + - 
painikkeella.  
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Voit jakaa hajotuspuussa näkyvää lukua osiin 
muillakin kriteereillä kuin hankintakategorian 
perusteella, kun lisäät visualisointiin useampia 
selittäviä kenttiä. Kentät näkyvät valikossa, kun 
ryhdyt pilkkomaan tietoja + -painikkeella. 
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5 Ylimääräinen lisätehtävä 

Tässä lisätehtävässä neuvotaan, miten raporttisivulle voi luoda Tyhjennä valinnat -tyyppinen painike, joka poistaa 

kaikki osittajien ja suodattimien valinnat.  

Jotta painike toimii, sinun pitää ensin luoda ns. kirjanmerkki, jonka avulla valinnat tyhjennetään. Kirjanmerkki tullaan 

kytkemään painikkeeseen. 

5.1 Kirjanmerkin luonti 

Siirry ensin Ostolaskut yleisnäkymä -sivulle ja tarkista, ettei mitään ole valittuna osittajista tai suodattimista.  

Tuo esiin kirjanmerkkien paneeli komennolla View > Bookmarks (Näytä > Kirjanmerkit). Paneeli avautuu oikealle. 

Tarkista vielä kerran, ettei mitään ole valittuna ja luo kirjanmerkki paneelissa olevan Add (Lisää) -toiminnon avulla. 

Vaihda muodostuneen kirjanmerkin nimeksi Ostolaskut yleisnäkymä – ei valintoja kaksoisnapsauttamalla 

kirjanmerkkiä. 

Lisää tämän jälkeen raporttisivulle painike komennolla Insert > Buttons > Blank (Lisää > Painikkeet > Tyhjä). Painike 

ilmestyy yleensä raporttisivun vasempaan yläkulmaan, mistä voit siirtää sen sivun oikeaan alakulmaan osittajien 

alapuolelle. Levennä painike osittajien kanssa yhtä leveäksi. 

Pidä painiketta valittuna, käy ottamassa teksti käyttöön 
ja kirjoita tekstiksi ”Tyhjennä valinnat”. Löydät sen 
muotoilupaneelista Button > Style > Text (Painike > 
Tyyli > Teksti).  
 

 
 

Ota ns. toiminto käyttöön ja kytke luotu kirjanmerkki 
painikkeeseen Button > Action > Action (Painike > 
Toiminto > Toiminto). 
 
Painike toimii Power BI Desktopissa, kun pidät Ctrl-
näppäintä pohjassa sitä napsauttaessasi. Power BI 
pilvipalvelussa se toimii tietenkin ilman Ctrl-näppäintä. 
 
Voit halutessasi muotoilla painikkeen ulkoasua Button > 
Style (Painike > Tyyli) -ryhmästä. 
 

 
 


